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[bookmark: _Toc62756088][bookmark: _Toc277652145][bookmark: _Toc298400708][bookmark: _Toc298411345][bookmark: _Toc521940694]Getting Started with Excel
[bookmark: _Toc62756089]Parts of a Spreadsheet
[image: ]Excel spreadsheets consist of columns, rows, cells and values.  In Excel, you work with worksheets, which consist of rows and columns that intersect to form cells.  Cells contain various kinds of data that you can format, sort, and analyze.  An Excel file is called a workbook, which by default comprises three worksheets.  Worksheets have a default name of Sheet1, Sheet2, etc.Worksheets Area[image: ]
Status Bar[image: ]
Zoom Options[image: ]
View Options[image: ]
Formula Bar[image: ]
Quick Access Toolbar
Ribbon[image: ]


[bookmark: _Toc269300044][bookmark: _Toc271699731][bookmark: _Toc287881600][bookmark: _Toc298400709][bookmark: _Toc298411346][bookmark: _Toc62756090]Quick Access Toolbar  
The Quick Access Toolbar is located by default at the top of the window and provides quick access to tools that you use frequently. You can customize the Quick Access Toolbar by adding commands to it.
[image: ]
To Customize the Quick Access Toolbar: 
1. Click on the down arrow located on the right end of the toolbar. 
2. Select an item from the list or click on More Commands.  This will open the Outlook Options window and take you to the Category for the Quick Access.
[bookmark: _Toc298400710][bookmark: _Toc298411347][bookmark: _Toc62756091]Ribbon
[bookmark: _Toc271699730][bookmark: _Toc287881599][image: ]The ribbon replaces traditional menus that had become increasingly cluttered as more features and commands were added. The Ribbon commands are organized into Tabs that group related commands together.   The Tabs are similar to the pull-down menus of past version.  Commands are separated into Groups across the Ribbon making it easier to locate items.

[bookmark: _Toc271699732][bookmark: _Toc287881601][bookmark: _Toc298400711][bookmark: _Toc298411348][bookmark: _Toc62756092]Dialog Box Launchers   
Dialog Box Launchers are small icons that appear in some groups. Clicking a Dialog Box Launcher opens a related dialog box or task pane, providing more options related to that group.  Dialog box launchers open familiar options from previous versions.  A Dialog Box Launcher icon is located at the bottom right corner of a group and looks like this [image: ].
[bookmark: _Toc271699721][bookmark: _Toc287881590][bookmark: _Toc298400713][bookmark: _Toc298411350][bookmark: _Toc62756093][bookmark: _Toc272499600]File Tab
The Ribbon contains the set of commands for working in a document, while the Microsoft Office Backstage view is the set of commands you use to do things to a document.

[bookmark: _Hlk11910849]The Backstage view is where you manage documents and related data about them — create, save, and send documents, inspect documents for hidden metadata or personal information, set options such as turning on or off AutoComplete suggestions, and more. 

NOTE: To quickly return to your document from the Backstage view, click the Home tab, or press ESC on your keyboard.

[image: ]The Microsoft Office Backstage view temporarily hides the document. To go back to your file again, click the Back Arrow at the top left of the Navigation Pane.

On the left of the menu, you see a list of commands like:
· Create a new document 
· Open an existing document
· Save and Save as (.pdf)
· Share (send as a .pdf)
· [bookmark: _Toc298400715][bookmark: _Toc298411352]Excel Options 
[bookmark: _Toc62756094]Formula Bar
In Excel 2016/19 you can expand the look of the formula bar.  This way, you can view more than 1 line of information at one time.
To expand the formula bar click on the [image: ] down arrow located to the right of the formula bar.
[bookmark: _Toc277652155][bookmark: _Toc298400722][bookmark: _Toc298411359][bookmark: _Toc62756095][bookmark: OLE_LINK3][bookmark: OLE_LINK4][bookmark: _Toc277652154][bookmark: _Toc298400721][bookmark: _Toc298411358]Zooming
You can zoom in to get a close-up view of your file or zoom out to see more of the page at a reduced size. You can also save a particular zoom setting with a document or template, presentation, or worksheet.
[image: ]Use the + or – signs to zoom in and out.  Use the slider bar to quickly move the zoom level.
[bookmark: _Toc277652156][bookmark: _Toc298400723][bookmark: _Toc298411360][bookmark: _Toc62756096]Views 
Changing the view in Excel 2016/19 is just a click away.  Toggle back and forth between Normal, Page Layout and Page Break Preview just by click on the button from the view area. 
[bookmark: _Toc62756097]Working in Excel
[bookmark: _Toc62756098]Mouse Shapes
When you are working in Excel, your mouse will change shape depending on where you currently have your mouse resting. Here are the different shapes: 
· Select - Thick plus shape[image: http://tortoiseshell.net/Graphics/excel_pointer_plus.png]
· Move - Mouse arrow with a compass shape incorporated [image: http://tortoiseshell.net/Graphics/excel_pointer_move.png]
· [image: ]Fill/Copy - A thin plus shape [image: http://tortoiseshell.net/Graphics/excel_pointer_copy.png]
· Column/Row Select - Small black arrow pointing down or to the right 
· [image: ]Column/Row Size - For column resize, black line with arrows pointing left and right (see image). For rows, black line with arrows pointing up and down. 
[bookmark: _Toc62756099]Navigating a Worksheet
Moving around in Excel can be done in several ways.  You can use the:
· Enter key to move down 1 row
· Tab key will move you 1 cell to the right
· Page up key will move you 1 screen up
· Page down key will move you 1 screen down
· CTRL HOME will move you to cell A1
· CTRL END will move you to the end of your work area
· HOME will move you to Column A within the active row
· Left Arrow key will move you 1 cell to the left
· Right Arrow key will move you 1 cell to the right
· Up Arrow key will move you 1 cell to the up
· Down Arrow key will move you 1 cell to the down
[bookmark: _Toc277652162][bookmark: _Toc298400724][bookmark: _Toc298411361][bookmark: _Toc62756100]Working with Ranges 
A range can be a single cell or a group of cells.  The cells do not have to be continuous or adjacent. The cells can be across multiple columns or rows. You will select cells to apply formatting, create formulas and much more. 



[bookmark: _Toc277652163][bookmark: _Toc298400725][bookmark: _Toc298411362][bookmark: _Toc62756101]Selecting Cells and Ranges
	To select
	Do this

	A single cell
	Click the cell, or press the arrow keys to move to the cell.

	A range of cells
	Click the first cell in the range, and then drag to the last cell, or hold down SHIFT while you press the arrow keys to extend the selection. 
You can also select the first cell in the range, and then press F8 to extend the selection by using the arrow keys. To stop extending the selection, press F8 again.

	A large range of cells
	Click the first cell in the range, and then hold down SHIFT while you click the last cell in the range. You can scroll to make the last cell visible.

	All cells on a worksheet
	[image: Select All button]Click the Select All button. 

To select the entire worksheet, you can also press CTRL+A. 
 NOTE    If the worksheet contains data, CTRL+A selects the current region. Pressing CTRL+A a second time selects the entire worksheet.

	Nonadjacent cells or cell ranges
	Select the first cell or range of cells, and then hold down CTRL while you select the other cells or ranges. 
You can also select the first cell or range of cells, and then press SHIFT+F8 to add another nonadjacent cell or range to the selection. To stop adding cells or ranges to the selection, press SHIFT+F8 again.
 NOTE    You cannot cancel the selection of a cell or range of cells in a nonadjacent selection without canceling the entire selection.

	An entire row or column
	Click the row or column heading. 

[image: Callout 1]Row heading
[image: Callout 2]Column heading
[image: Worksheet showing row heading and column heading]You can also select cells in a row or column by selecting the first cell and then pressing CTRL+SHIFT+ARROW key (RIGHT ARROW or LEFT ARROW for rows, UP ARROW or DOWN ARROW for columns).
Note: If the row or column contains data, CTRL+SHIFT+ARROW key selects the row or column to the last used cell. Pressing CTRL+SHIFT+ARROW key a second time selects the entire row or column.

	Adjacent rows or columns
	Drag across the row or column headings. Or select the first row or column; then hold down SHIFT while you select the last row or column.

	Nonadjacent rows or columns
	Click the column or row heading of the first row or column in your selection; then hold down CTRL while you click the column or row headings of other rows or columns that you want to add to the selection.

	The first or last cell in a row or column
	Select a cell in the row or column, and then press CTRL+ARROW key (RIGHT ARROW or LEFT ARROW for rows, UP ARROW or DOWN ARROW for columns).

	The first or last cell on a worksheet or in a Microsoft Office Excel table
	Press CTRL+HOME to select the first cell on the worksheet or in an Excel list. 
Press CTRL+END to select the last cell on the worksheet or in an Excel list that contains data or formatting.

	Cells to the last used cell on the worksheet (lower-right corner)
	Select the first cell, and then press CTRL+SHIFT+END to extend the selection of cells to the last used cell on the worksheet (lower-right corner).

	Cells to the beginning of the worksheet
	Select the first cell, and then press CTRL+SHIFT+HOME to extend the selection of cells to the beginning of the worksheet.

	More or fewer cells than the active selection
	Hold down SHIFT while you click the last cell that you want to include in the new selection. The rectangular range between the active cell (active cell: The selected cell in which data is entered when you begin typing. Only one cell is active at a time. The active cell is bounded by a heavy border.) and the cell that you click becomes the new selection.





If you want to continue selecting cells after you have the first cell or range of cells selected you can use your CTRL key.
· Hold the CTRL key down while you click on a single cell or click and drag to select multiple cells.Use the CTRL or SHIFT key to help you select cells.

· You can use the SHIFT key to select cells by click on the first cell (top left cell of the range) then hold the SHIFT key down and click on the last cell in the range (the bottom right cell or last cell).
[bookmark: _Toc62756105][bookmark: _Toc277652164][bookmark: _Toc298400736][bookmark: _Toc298411368]Working with Data in Excel
[bookmark: _Toc277652157][bookmark: _Toc298400726][bookmark: _Toc298411363][bookmark: _Toc62756106]Entering Data
[bookmark: backtotop]You have several options when you want to enter data manually in Excel. You can enter data in one cell, in several cells at the same time, or on more than one worksheet (worksheet: The primary document that you use in Excel to store and work with data. Also called a spreadsheet. A worksheet consists of cells that are organized into columns and rows; a worksheet is always stored in a workbook.) at once. The data that you enter can be numbers, text, dates, or times. You can format the data in a variety of ways. And, there are several settings that you can adjust to make data entry easier for you.
[bookmark: _Toc277652158][bookmark: _Toc298400727][bookmark: _Toc298411364][bookmark: _Toc62756107][image: ]Enter text or a number in a cell
1. On the worksheet, click a cell. 
2. Type the numbers or text that you want to enter, and then press ENTER or TAB. 

Notes: 
· Numbers align to the right of the cell and text aligns to the left of the cell.
· Excel assumes numbers will be part of a calculation.  If you enter a number that you want to use for a column or row heading you may want to format the number as text.  You can place an ‘ (apostrophe) in front of the number.
[bookmark: _Toc277652159][bookmark: _Toc298400728][bookmark: _Toc298411365][bookmark: _Toc62756108]Edit text or numbers in a cell
You can edit the contents of a cell directly in the cell. You can also edit the contents of a cell by typing in the formula bar.  When you edit the contents of a cell, Excel is operating in Edit mode.  Some Excel features work differently or are unavailable while in Edit mode.
There are several ways to edit the contents of a cell.
· Click once in the cell and use the Formula Bar to edit.
· Double click in the cell and edit within the cell.
· Press F2 and edit the contents within the cell.

When Excel is in Edit mode, the word Edit [image: ] appears in the lower-left corner of the window in the Status Bar. 
[bookmark: _Toc62756109]Fill Options
[image: ]Many of the worksheets that you create with Excel require the entry of a series of sequential dates or numbers. For example, a worksheet may require you to title the columns with the 12 months, from January through December, or to number the rows from 1 to 100.
[image: ]Excel’s AutoFill feature makes short work of this kind of repetitive task. All you have to enter is the initial value in that series. In most cases, AutoFill is smart enough to figure out how to fill out the series for you when you drag the fill handle to the right. 
Use the “Fill” handle located at the bottom right corner of a cell. Then click and drag to fill in data. 
[bookmark: _Toc62756116]Perform Calculations on Data
[bookmark: _Toc298400742][bookmark: _Toc298411374][bookmark: _Toc62756117]Formulas
You use formulas to perform calculations such as adding, multiplying, and averaging.  All formulas begin with an = equal sign.  A formula can refer to a value, a cell address, another formula, or range names.  You can also use special formulas called functions to perform calculations.  Functions are predefined formulas that perform calculations, which can range from simple to complex.

Formulas contain operators that indicate the type of calculation that the formula will perform.  The following are a list of operators commonly used in Excel:

	Operator
	Used to…
	Example

	+
	Add numbers
	=A7+A9

	-
	Subtract numbers
	=A7-A9

	*
	Multiply numbers
	=A7*A9

	/
	Divide numbers
	=A7/A9

	%
	Specify the percentage of a number
	=50%

	^
	Specify the exponent
	=5^3 means 5 raised to the third power or 5*5*5



[image: ]You can create a simple formula by using constants and calculation operators and reference operators. For example, the formula =5+2*3, multiplies two numbers and then adds a number to the result. Microsoft Office Excel follows the standard order of mathematical operations. In the preceding example, the multiplication operation (2*3) is performed first, and then 5 is added to its result. 

You can also create a formula by using a function. For example, the formulas =SUM(A1:A2) and SUM(A1,A2) both use the SUM function to add the values in cells A1 and A2.

Note:
· When you create a formula, the answer will appear in the cell where you created the formula and the formula will be displayed in the Formula Bar.
[bookmark: Enter_constants_in_a_formula][bookmark: _Toc277652180][bookmark: _Toc298400744][bookmark: _Toc298411376][bookmark: _Toc62756118]Create a formula using Operators
1. Click the cell in which you want to enter the formula. 
2. Type = (equal sign). 
3. To enter the formula, do one of the following: 
4. Type the constants and operators that you want to use in the calculation. 
5. Click the cell that contains the value that you want to use in the formula, type the operator that you want to use, and then click another cell that contains a value. 

To create a reference, select a cell, a range of cells, a location in another worksheet, or a location in another workbook. This behavior is called semi-selection. You can drag the border of the cell selection to move the selection or drag the corner of the border to expand the selection. 
[image: Range Finder color-codes precedent cells]
[image: Callout 1]The first cell reference is B3, the color is blue, and the cell range has a blue border with square corners.
[image: Callout 2]The second cell reference is C3, the color is green, and the cell range has a green border with square corners.
[bookmark: _Toc277652179][bookmark: _Toc298400743][bookmark: _Toc298411375][bookmark: _Toc62756119][bookmark: _Toc277652181][bookmark: _Toc298400745][bookmark: _Toc298411377]Order of Operations
Excel follows the Order of Precedence –Parentheses, Exponents, Multiplication and Division, Addition and Subtraction = Please Excuse My Dear Aunt Sally.

Therefore, if we calculate =5+2*3.  This would equal 11.  In contrast, if you use parentheses to change the syntax, Excel adds 5 and 2 together and then multiplies the result by 3 to produce 21. =(5+2)*3
[bookmark: _Toc62756120]Functions
Sometimes you might want to calculate the sum of values in a range of cells.  This can be difficult and time-consuming.  For example, if you have a range consisting of 20 cells, the formula to calculate the sum of all these values will be very long.  Excel provides various functions that you can use to do such complex tasks.  A function is a predefined formula that performs a specific type of calculation.  You specify the values on which the function performs calculations.

Functions have the following structure:  =Function Name(argument1, argument2, …)

As with all formulas, you begin with an = equal sign, followed by the name of the function.  Next you enter a set of parentheses, inside of which you list the input values for the function.

Arguments are the input values of a function.  Arguments can be numbers, text, cell addresses, ranges, or several other types of data.
[bookmark: _Toc10112720][bookmark: _Toc62756121]Function Categories
· Financial: Performs common business calculations including accounting and finance.
· Date & Time: Performs functions involving date or time data.
· Math & Trig: Performs simple to complex mathematical functions.
· Statistical: Performs statistical analysis on ranges of data.
· Lookup & Reference: Finds values in a corresponding table or list and incorporates the data into the calculation.
· Database: Performs a function only on data that meets a criterion.
· Text: Allows text to be manipulated within a calculation that also contains data.
· Logical: Performs what-if analysis to see if a condition is true or false.
[bookmark: _Toc277652182][bookmark: _Toc298400746][bookmark: _Toc298411378][bookmark: _Toc62756122]To create a formula using a function
1. Click the cell in which you want to enter the formula. 
2. To start the formula with the function, click Insert Function [image: Button image]on the formula bar [image: Formula bar]. 
3. Select the function that you want to use. 
4. You can enter a question that describes what you want to do in the Search for a function box (for example, "add numbers" returns the SUM function), or browse from the categories in the Or Select a category box. 
5. Enter the arguments. 
Note:  To enter cell references as an argument, click Collapse Dialog [image: Button image](which temporarily hides the dialog box), select the cells on the worksheet, and then press Expand Dialog [image: Button image].
	Example formula
	What it does

	=SUM(A:A)
	Adds all numbers in column A

	=AVERAGE(A1:B4)
	Averages all numbers in the range


6. After you complete the formula, press ENTER. 

Note:  To summarize values quickly, you can also use AutoSum. On the Home tab, in the Editing group, click AutoSum, and then click the function that you want.

If you use Excel, there are some key functions that everyone should know, regardless of what industry you work in or what your role is. Most popular are: Sum, Average, and Count.

[bookmark: _Toc277652183][bookmark: _Toc298400747][bookmark: _Toc298411379][bookmark: _Toc62756123]Using AutoSum
[image: ]The SUM function is useful when you want to add values from different ranges or combine number values with ranges of numbers. Use the SUM function to add all the arguments that you specify within the opening and closing parentheses. Each argument can be a range, a cell reference, or a numeric value.
1. If you have a row or column of numbers that you want to add together click in the cell where you want your answer to appear, then click the AutoSum Icon[image: ].
2. If the range is correct press enter.

Note: You can also use the AutoSum drop down menu to gain access to other popular Auto Functions like Average, Min, Max, and Count.
[bookmark: _Toc340166937][bookmark: _Toc371526411][bookmark: _Toc62756124]AutoSum Shortcuts
There are multiple ways to using the AutoSum.  Some automatic ways are:
· Select the blank cells where you want the answers to appear. Then click on AutoSum.
· Select the range of cells including the row for the answers. Then click on AutoSum.
[bookmark: _Toc305662187][bookmark: _Toc317682488][bookmark: _Toc371526301][bookmark: _Toc62756125]Average, MAX, & MIN Functions
· The AVERAGE function, Returns the average (arithmetic mean) of the arguments. Example, if the range A1:A20 contains numbers, the formula =AVERAGE(A1:A20) returns the average of those numbers.
· The MAX function, one of Excel's statistical functions, is used to find the largest or maximum number in a given list of values or arguments. The formula =MAX(A1:A20) returns the largest number in the range.
· The MIN function, one of Excel's statistical functions, is used to find the smallest or minimum value in a list of numbers or arguments. The formula =MIN(A1:A20) returns the smallest number in the range.

[bookmark: _Toc62756138]Change Workbook Appearance
[bookmark: _Toc62756139]Working with Rows and Columns
[bookmark: _Toc277652171][bookmark: _Toc298400732][bookmark: _Toc298411388][bookmark: _Toc62756140]Changing the Width and Height
On a worksheet, you can specify a column width of 0 (zero) to 255. This value represents the number of characters that can be displayed in a cell that is formatted with the standard font. The default column width is 8.43 characters. If a column has a width of 0 (zero), the column is hidden.

You can specify a row height of 0 (zero) to 409. This value represents the height measurement in points (1 point equals approximately 1/72 inch or 0.035 cm). The default row height is 12.75 points (approximately 1/6 inch or 0.4 cm). If a row has a height of 0 (zero), the row is hidden.

To adjust the width or height automatically to the widest text or tallest font, you can 
· When you hesitate on the line between the columns you will get a left and right arrow.
· When you hesitate on the line between the rows you will get an up and down arrow.

[bookmark: InsertRows]You can click and drag that arrow to adjust the height or width or double click on the bar to the right of the column or the row below to auto adjust.
[bookmark: _Toc277652172][bookmark: _Toc298400733][bookmark: _Toc298411389][bookmark: _Toc62756141]Insert Rows 
Do one of the following: 
· To insert a single row, select either the whole row or a cell in the row above which you want to insert the new row. For example, to insert a new row above row 5, click a cell in row 5. 
· To insert multiple rows, select the rows above which you want to insert rows. Select the same number of rows as you want to insert. For example, to insert three new rows, you select three rows. 
· To insert nonadjacent rows, hold  down CTRL while you select nonadjacent rows.
· [image: ]Use the Insert option from the Ribbon on the Home tab

Tip:  You can also right-click the selected rows and then left click on Insert.

Note:   When you insert rows on your worksheet, all references that are affected by the insertion adjust accordingly, whether they are relative or absolute cell references. The same behavior applies to deleting rows, except when a deleted cell is directly referenced by a formula. If you want references to adjust automatically, it's a good idea to use range references whenever appropriate in your formulas, rather than specifying individual cells.
[bookmark: _Toc277652174][bookmark: _Toc298400734][bookmark: _Toc298411390][bookmark: _Toc62756142]Hiding Rows or Columns
You can hide a row or column by using the Hide command, but a row or column also becomes hidden when you change its row height or column width to 0 (zero).  You can display them again by using the Unhide command.

You can either unhide specific rows and columns, or you can unhide all hidden rows and columns at once.  The first row or column of the worksheet is tricky to unhide, but it can be done.

1. Select the Columns or Rows you want to Hide.  (Use the column or row indicators.)
2. Then right-click on the selected area and left-click on Hide.

To Unhide the columns or rows – Select the surrounding columns or rows that you want to unhide then right-click on the selected area and left-click on Unhide.

Note:  You can also right click a row or column (or a selection of multiple rows or columns), and then click Hide.
[bookmark: _Toc277652173][bookmark: _Toc298400735][bookmark: _Toc298411391][bookmark: _Toc62756143][image: ]Freezing Rows or Columns
To Freeze you need to be on the cell that is to the right of the column you want to freeze and on the row below the row you want to freeze.  Example:  If you want to Freeze Column A and B and Rows 1 and 2 you would need to be on cell C3.

1. Select the column(s) or row(s) you want to Freeze go to the View tab on the Ribbon
2. Click on Freeze Panes, then Freeze Panes.

To Unfreeze go to the View tab on the Ribbon, click on Freeze Panes, then UnFreeze Panes.
[bookmark: _Toc62756151]Using Cell Styles
A style is simply a collection of formatting options, such as font size, cell color and border style settings, saved with a sensible name and which can be applied to cells quickly.
Microsoft Office Excel has several built-in cell styles that you can apply or modify. You can also modify or duplicate a cell style to create your own, custom cell style.
Cell styles are based on the document theme that is applied to the whole workbook. When you switch to another document theme, the cell styles are updated to match the new document theme.
Cell Styles can be quicker and easier to use as well as keep you consist on the formatting you are using within your workbook.
Apply a cell style
1. Select the cells that you want to format. 
2. On the Home tab, in the Styles group, click the More dropdown arrow in the style gallery, and select the cell style that you want to apply.[image: ]
[bookmark: _Toc62756115][bookmark: _Toc62756110]Flash Fill
Flash Fill automatically fills your data when it senses a pattern. For example, you can use Flash Fill to separate first and last names from a single column or combine first and last names from two different columns.
Let's say column A contains first names, column B has last names, and you want to fill column C with first and last names combined. If you establish a pattern by typing the full name in column C, Excel's Flash Fill feature will fill in the rest for you based on the pattern you provide.
1. [image: Graphical user interface, table, Excel

Description automatically generated]Enter the full name in cell C2, and press ENTER.
2. Start typing the next full name in cell C3. Excel will sense the pattern you provide and show you a preview of the rest of the column filled in with your combined text. 
3. To accept the preview, press ENTER.
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